Hackathon Kit #dataTXT

Prima di tutto questo & un brogliaccio, che si pud commentare ed usare come facilitatore. Per
partire con il piede giusto, ecco il quadro delle cose che si possono fare con i dati: ( preso da
vecchi contest sul tema )

Processo Descrizione

IUn dataset viene utilizzato direttamente
per identificare un preciso fatto di

Data > Fatto interesse.

Es. Far emergere la storia ed il percorso divoto d
un determinato decreto legge ...

Ricerca, Naviga, Estrai

|l contenuto di un dataset viene espresso
attraverso un'infografica, che & una singola

Data > Informazione interpretazione di quei dati, ed un'unica
) ) rappresentazione.
Manipolare, analizzare
statisticamente, visualizzare, Es. Le infografiche sui dati di dati.piemante.
contestualizzare, creare repart it realizzate da Visup.it

Sifornisce un'interfaccia che permette una
Data » |nterfaccia rappresentazione interattiva del dataset, sulla
base delle azioni dell'utente.

. FPulire, pomblr_ware, sele_zmnare, con_flgurare Es. mashup su mappa interattiva e
un'interfaccia, scrivere codice pelrsonallzzato per la ricercabile di dati anche geografici
logica, e famire I'UI significativi ed integrati con altri

Un dataset derivato, che viene fomito per il
Data - Data download, o per I'acce sso via APl o similari.

Es. dal datasetin XML di Open Camera, al

Convertire il formato, filtrare i dati, combinare e ! "~
migliorare il risultato, fornire delle API, ed il dataset dataset Llnk_ed Dat? con APl e SPARQL
Endopoint su linkedopendata it

per il download

_ . Sifomisce un servizio basato sugli open
Data > Servizio data, che non & detto sia pensato per l'utente
finale

Integrare i dati in un prodotto/servizio gia
esistente, crearne una nuova

Cosa dovresti fare, per non perdere tempo dopo

Per usare le API di dataTXT ti servono due cose:
-> app_key e app_id

Che poi si usino le REST API, o si usino le integrazioni a Open Refine, o la libreria Python
dedicata, poco importa: queste sono necessarie.

2 minuti e le avrai: https://dandelion.eu/accounts/reqister/



https://dandelion.eu/accounts/register/

d an d = l|o n Products ~ Pricing Docs Login Sign Up

Get started with a Free Account.

2
REGISTER WITH n E @ m Already have an account?

OR LOGIN

Full name
Username*
Password*
Organization

E-mail*

Una volta iscritto, loggati su dandelion.eu, e in alto a destra troverai il tuo username, con un
menu a tendina, da dove potrai raggiungere la dashboard:

Ciao dagoneye! ~

Dashboard

La tua dashboard avra i valori dell’ app_key e dell’app_id che potrai usare:



d an d e |.| on Products ~ Pricing

Dashboard of Matteo Brunati

API credentials

AppiD @ App Key R -

Refurbish key

1 000 . Not enough units?
units left
Next reset in 15 hours from now UPGRADE PLAN



Cosa a fa dataTXT ( parte intro, se vuoi il codice, vai avanti )

La famiglia di dataTXT - https://dandelion.eu/products/datatxt/ - fa diverse cose:

e dataTXT-NEX - estrae, disambigua e linka alle risorse su Wikipedia
o demo https://dandelion.eu/products/datatxt/nex/demo/

e dataTXT-SIM - calcola la similarita tra due testi, ottimizzata per le frasi brevi
o demo https://dandelion.eu/products/datatxt/sim/demo/?exec=true

Dettaglio su dataTXT-NEX

Dato in input un testo (una frase o un testo molto lungo), trova le entita presenti nel testo
(luoghi, persone, organizzazioni, etc.) e le collega alla corrispondente pagina Wikipedia /
DBpedia.

An apple is better than an orange

OrangXtelco )

N \/

An apple is better than an orange



https://dandelion.eu/products/datatxt/
https://dandelion.eu/products/datatxt/nex/demo/
https://dandelion.eu/products/datatxt/sim/demo/?exec=true

DBpedia & una conversione di Wikipedia in forma di database interrogabile. Si tratta di un
progetto di Open Community Data.
Maggiori informazioni: http:/it.dbpedia.org
Un esempio di "entita" su DBpedia: http://it.dbpedia.org/page/Venezia

L'accoppiata delle due tecnologie ( DBpedia usa il mondo del Linked Open Data ) quindi
permette:

e con dataTXT trovi le entita presenti in un testo (un documento, un post su un forum, un
tweet, un articolo di giornale, I'imput dell'utente, una colonna di descrizione di una
delibera da una fonte Open Data in csv, un URL di un blog post online... etc.) con un link
a DBpedia / Wikipedia, ovvero non solo capisci che & un nome di persona, oppure il
nome del luogo, ma capisce quale persona e quale luogo, linkandolo (in gergo sono
estratte quindi non con un servizio di Entity Extraction, ma di Named Entity Extraction )

e Con una query su DBpedia si ottengono maggiori info sull'entita in questione, rendendo
piu "intelligenti" le applicazioni che consumano questi dati. Ad esempio i luoghi su
DBpedia hanno gia le coordinate geografiche

e puoi usare 'URI/URL dell’entita come chiave per disambiguare e usarla come
identificativo univoco...

Tutto questo funziona perché dataTXT si appoggia al grafo sottostante di dandelion.eu, che

integra il grafo di Wikipedia, OpenStreetMap ed altre fonti, anche proprietarie:

DATATXT API

| DATATXT API

.00

LINKED CORPORATE DATA@



http://it.dbpedia.org/
http://it.dbpedia.org/page/Venezia

Perché e importante il contesto?

Perché Facebook ha cosi tanto valore oggi? O what’s up?
Perché ha utenti, tanti utenti. E perché c’é una legge, la legge di MetCalfe che dice:

>> | 'utilita e il valore di una rete sono pari ad n*2 - n dove n & il numero degli utenti

a =R

Bt

g
e

Ed entrambi quei servizi sono social network, ovvero sono delle reti sociali abilitate e costruite
attraverso la tecnologia, in un certo senso.

Se lo applichiamo al mondo dei dati, allora significa che:
-> maggior contesto e quindi dati correlati, maggior sara I'utilita percepita

DATI + LINK + INFO CORRELATE

Ovvero:


http://it.wikipedia.org/wiki/Legge_di_Metcalfe

testo semplice >> dataTXT >> luoghi
persone
concetti e tag + link a Wikipedia / DBpedia
opere

=

dbpedia:Firenze
City

ato:mentions

A_\ dbpedia:Don_Chisciotte

cro:mentions
| Book

catomentons

cito:mentions dbpedia:ESper‘antO

Lingua

dbpedia:Battaglia_di_Caporetto

Event
datax dbpedia:Goethe

SPAZIODATL” Person/Writer

esempio di utilizzo -> http://www.slideshare.net/christianmorbidoni/gramsci-sourcelod2014-roma

Ah, ovviamente su dandelion.eu esiste una demo a partire dall'input dell’'utente o URL, per farvi
vedere alcune delle potenzialita:
-> https://dandelion.eu/products/datatxt/nex/demo/?exec=true#results

Occhio che & una semplice interfaccia utente al di sopra dell’API di base.


http://www.slideshare.net/christianmorbidoni/gramsci-sourcelod2014-roma
https://dandelion.eu/products/datatxt/nex/demo/?exec=true#results

Cosa fa dataTXT? ( codice )

Partiamo dalle basi della doc:
https://dandelion.eu/docs/api/datatxt/nex/getting-started/

ovvero se ho una richiesta API di questo tipo:

https://api.dandelion.eu/datatxt/nex/v1/?lang=en&text=The doctor S
ays an apple is better than an orange&include=ty
pes abstract categories lod&$app_id=YOUR_APP_ID&$app_key=
YOUR_APP_KEY

avro una risposta di questo tipo:
-> https://dandelion.eu/docs/api/datatxt/nex/v1/#example

Cosa ci potrai fare & ora riflessione collettiva :)


https://dandelion.eu/docs/api/datatxt/nex/getting-started/
https://dandelion.eu/docs/api/datatxt/nex/v1/#example

Come puoi usare dataTXT: tools

1. Primo livello: usare direttamente le REST dataTXT-NEX API, magari attraverso UniRest
- http://unirest.io/ con il linguaggio che preferisci.

2. Secondo livello: usare la libreria nativa in Python

3. Terzo livello: usare Open Refine per pulizia, normalizzazione dei dati e link verso
wikipedia da colonne di testo di descrizioni o simili ( ha meno senso usarlo per colonne
di dati/testi gia puliti e di un solo tipo di entita ) - un esempio su uno dei dataset presente
su dati.veneto.it si trova verso la fine del documento

Dandelion-eu : la libreria ufficiale se usi Python

Come installarla via PyPl, il Python Package Index.

pip install dandelion-eu

Oppure da GitHub - https://github.com/SpazioDati/python-dandelion-eu
Documentazione di riferimento: http:/python-dandelion-eu.readthedocs.org/en/latest/

Impostare le proprie credenziali che vi siete salvati:
http://python-dandelion-eu.readthedocs.org/en/latest/base.html#authentication

>>> from dandelion import DataTXT

>>> datatxt = DataTXT(app_id='YOUR_APP_ID', app_key='YOUR_APP_KEY")
>>> response = datatxt.nex('The doctor says an apple is better than an
orange')

>>> for annotation in response.annotations:

print annotation

€ poi via, pronto all’'uso!

SDK per gli altri linguaggi

Un consiglio spassionato? Usare UniRest - hitp://unirest.io/ + documentazione ufficiale sulle
nostre API| di dataTXT.


http://unirest.io/
https://pypi.python.org/pypi/
https://github.com/SpazioDati/python-dandelion-eu
http://python-dandelion-eu.readthedocs.org/en/latest/
http://python-dandelion-eu.readthedocs.org/en/latest/base.html#authentication
http://unirest.io/

Casi e scenari di utilizzo per dataTXT

e tutto quello che implica dover gestire testi semplici e renderli “actionable” ovvero

collegarli con altri dati, partendo dal contesto delle informazioni correlate tratte da
Wikipedia per abilitare filtri, navigazioni a faccette dei dati, o cose del genere.

o Esempio: integrazione tra DocumentCloud (http://www.documentcloud.org/home)

e dataTXT per navigare nei documenti PDF della commissione parlamentare
sulla P2.

-> http://fontitaliarepubblicana.it/ - entrando nel sito si accede alla ricerca

Quando si clicca sulla voce “vedi le entita” la navigazione e 'estrazione di quelle entita
avviene tramite le API di dataTXT.


http://www.documentcloud.org/home
http://fontitaliarepubblicana.it/

Scenari

e trovare contenuti correlati, specie a partire da testi brevi provenienti dai social media, per
dare maggior contesto ai dati estratti dal mondo Open Government Data, per linkarli e
renderli connessi con informazioni aggiornate dal Real-Time Web ( Twitter, Facebook
status, e simili... )

e abilitare ricerche full text e granulari per tipo di entita presente nel contenuto dei dati da
trattare, magari gia collegati tra di loro per tema o contesto, per andare oltre al motore
tematico offerto da hack4dmed ( che ricerca solo nei metadati associati ai singoli datasets
)

e fare data dissemination: sfruttare la diffusione di Wordpress per fare un plugin che
permetta la navigazione trasversale di alcuni dei dati pubblicati -> trasparenza, senso
civico ( e qui ci sono gli atti raccontati attraverso descrizioni che sono filtrabili usando
dataTXT, ad esempio... )

e ambito turistico - replicare il widget prototipo di TINDES usando dataTXT per aggregare
fonti dal mondo social, ed aumentare I'attualita del valore de dato turistico, o culturale,
con dati aggiornati provenienti dagli utenti -
http://www.slideshare.net/barbz79it/tindes-esempio-di-riuso-degli-opendata-in-trentino

e preparare dataset puliti e correlati nativamente ad altre fonti: se troviamo una fonte dati
molto sporca, oppure che debba essere esplorata, I'uso di Open Refine & fondamentale.
Quando poi si ha:

o una colonna di descrizione, magari di delibere o di descrizioni di luoghi o
semplicemente di titoli di libri ad esempio
-> posso ottenere una selezione di parole chiave da usare nella app o per creare
faccetteffiltri di navigazione in maniera automatica con I'estensione “Named Entity
Extraction” installabile su Open Refine

Dove scaricare Open Refine

- Open Refine - versione ufficiale - meglio scaricare la stable
http://openrefine.org/download.html
( occhio alla versione su macosx, potrebbe avere dei problemi legati alle impostazioni di
sicurezza, nel caso:
e Open System Preferences
e Open Security & Privacy
e Go to the General Tab
e "Allow applications downloaded from:" setting to "Anywhere" )

-> va installata questa estensione http://freeyourmetadata.org/named-entity-extraction/



http://www.slideshare.net/barbz79it/tindes-esempio-di-riuso-degli-opendata-in-trentino
http://openrefine.org/download.html
http://freeyourmetadata.org/named-entity-extraction/

Cosa fa l’estensione “Named Entity Extraction” configurata con dataTXT

Partiamo da esempio operativo su un set di dati con una colonna di testo descrittiva:
http://dati.veneto.it/dataset/libri-editi-o-promossi-dalla-regione-del-veneto

1. Scarichiamo il dataset in formato XLS.
2. Apriamo Open Refine e creiamo un nuovo progetto, importando il file:

A power tool for working with messy data.

Create a project by importing data. What kinds of data files can | import?
TSV, CSV, *SV, Excel (.xIs and .xIsx), JSON, XML, RDF as XML, and Google Data documents are all supported. Support for other form

extensions.
Get data from Locate one or more files on your computer to upload:
This Computer ‘Scegli file | catalogostorico01012014.xIs
Web Addresses (URLs) Next »
Clipboard
Google Data

Al passaggio successivo, avremo un’anteprima dei dati presenti nel file:

« Start Over  Configure Parsing Options Project name catalogostorico01012014 xls Create Project »
IdOpera Autore Titolo SottoTitolo Anno Collana Materia SottoMateria
il 1 DIPARTIMENTO PER IL ALBO OPERATORI TURISTICI 1991 STORIA Geografia-
TURISMO Turismo
2. 2 AAVV. ALIMENTAZIONE E SALUTE. GUIDA METODOLOGICA 1991 SCIENZE Educazione-
PER L'EDUCAZIONE ALIMENTARE SOCIALI Formazione-
Istruzione
3. 3 AAVV. ANALISI DENDROCRONOLOGICA DELLE FORESTE DEL 1990 SCIENZE Sc.naturali-
VENETO PURE Geologia-
Sc.biologiche
4. 4 AAVV. ANNALE NIVOMETEOROLOGICO DELLA MONTAGNA SCIENZE Sc.naturali-
VENETA-ANNI 1985-1986-1987 PURE Geologia-
Sc.biologiche
5. 5 SANTSCHIE. BENEDETTINI IN S.DANIELE (1046-1198) 1989 FONTIRELATIVE ALLA STORIA Storia
STORIA DI VENEZIA
6. 6 AAVV. ANNALE NIVOMETEOROLOGICO DELLA MONTAGNA 1992 SCIENZE Sc.naturali-
VENETA. ANNO 1988 PURE Geologia-
Sc.biologiche
U 7 AAVV. ANNALE NIVOMETEOROLOGICO DELLA MONTAGNA 1992 SCIENZE Sc.naturali-
\/EAIETA ARNKNN 1000 DlLIDE NRanlanin
Parse data as Update Preview
Excel files Worksheets to Ignore 0  Store blank rows
JSON files Import first  Jing(s) at  Store blank cells as nulls
 Estrazione 2168 beginning Store file source
Line-based text files Libri rows of file e
(file names, URLs)
CSV / TSV / separator-based files  Parse 1 in each row
. ate) > next Jine(s) as
Fixed-width field text files column
PC-Axis text files headers
X Discard 0
RDF/N3 files initial row(s) of
XML files data
Load at 0

Open Document Format spreadsheets t
(-ods) most row(s) of


http://dati.veneto.it/dataset/libri-editi-o-promossi-dalla-regione-del-veneto

Una volta aperto Open Refine la prima volta con I'estensione installata, dovremo configurare
I'estensione con le proprie credenziali ( app_key e app_id ).
In alto a destra c’é la voce “Extensions: Named-entity recognition”:

I Open... H Export ~ ][ Help ]

isions:  Named-entity recognition ~ | Freebase ~ | RDF +
Configure services... s lasts
v|sc About I_ZI Sotto
1991 ' 'STORIA  Geografia
Turismo
1991 SCIENZE Educazior
IE SOCIALI Formazior
Istruzione
ZLLE 1990 SCIENZE Sc.natural
PURE Geologia-
Sc.biologic
Tr A orICNT7TE Cm mmdsnmm|

Alla voce “Configure services” arriveremo a questa finestra :

Services — Named-Entity Recognition

AlchemyAPI configuration instructions
APl key

DBpedia Spotlight
This service requires no configuration.

Zemanta configuration instructions
APl key |

dataTXT configuration instructions
App ID [

App key




Dovrai quindi inserire le tue “app ID” e “’App key” per abilitare 'uso di dataTXT: se non ricordi
dove sono, le trovi su dandelion.eu -> dnome utente in alto a destra -> dashboard.
( come descritto nella sezione iniziale di questo documento )

Una volta quindi configurato il plugin, sara possibile selezionare quella colonna contenente i
testi da filtrare grazie a dataTXT. La colonna del titolo & ottimale: ha testi corti, e con temi
specifici. Cliccando sul nome della colonna potremo accedere a questo menu:

2167 rows Extensions: Named-entity recognition ~ = Freeb
Show as: rows records Show: 5 10 25 50 rows ous 1-
v Al v IdOpera ¥ Autore ¥ Titolo ¥ | SottoTitolo | ¥ Anno ¥ Collana
1. 1 DIPARTIMENTO PER IL Facet » 1991
TURISMO
2. 2 AAW. Texthlier SUIDA 1991
) CAZIONE
Edit cells 4
3. 3 AAWV. Edit column ) BICADELLE 1990
Transpose »
4, 4 AAWV. ICO DELLA
Sort... 85-1986-1987
5. 5 SANTSCHIE. View * hoss-1198) 1989 FONTI RELATIVE
. ALLA STORIA DI
Reconcile » VENEZIA
6. 6 AAVV. » ICO DELLA 1992
Extract named entities... }ggg
T 7 AAWV. ANNALE NIVOMETEOROLOGICO DELLA 1992

MONTAGNA VENETA. ANNO 1989

8. 8 AAW. ANNALE NIVOMETEOROLOGICO DELLA 1992
MONTAGNA VENETA. ANNO 1990

9. 9 AAW. ANNALE NIVOMETEOROLOGICO DELLA 1992
MONTAGNA VENETA. ANNO 1991

10. 10 DIPARTIMENTO SERVIZI ANNATE AGRARIE 1989-1990 NEL VENETO.

epcAiAl bED 1 IDEDCIAT IRVECTITE £ DISHI TATI BDARIITTAA

Cliccando alla voce “Extract Named entities” apparira una finestra di questo tipo:



dOpera ¥ | Autore | ¥ Titolo

Extract named entities in Titolo
DA
IONE
Extract named entity in the Titolo column using the
following services: A DELLE
Y DELLA
| DBpedia Spotlight H986-19
Confidence 0.5
B-1198)
Support 30
Zemants DELLA
B
o dataTXT
Confidence 0.6 DELLA
e — b
Parse hashtag false
DELLA
Language auto
Min length 2 =
L VENEI
Cancel Start extraction | [\I!PRC
1T AAVV. ARTIGIANATO ARTISTICO. STOCCOLM/

| parametri da configurare sono quelli che si trovano nella doc ufficiale:
-> https://dandelion.eu/docs/api/datatxt/nex/v1/#parameters

Quello piu importante & quello della confidence, che rappresenta il valore di qualita del matching
con I'entita.
Una volta impostati i valori, cliccando su “Start extraction” otterremo:

e una nuova area che avvisa del lavoro in corso batch sulla colonna “Titolo”: in base al
numero di righe ed alla complessita/lunghezza del testo da analizzare, sara un processo
piu 0 meno lungo

Recognize named entities in column Titolo

112014 xIs Permalink 1% complete Cancel
2167 rows Extensi
Show as: rows records Show: 5 10 25 50 rows
v Al ¥ |dOpera ¥ Autore ¥ Titolo
1. 1 DIPARTIMENTO PER IL ALBO OPERATORI TURISTICI
TURISMO
2. 2 AAVV. ALIMENTAZIONE E SALUTE. GUIDA
METODOLOGICA PER L'EDUCAZIONE
ALIMENTARE
3. 3 AAVV. ANALIS| DENDROCRONOLOGICA DELLE
FORESTE DEL VENETO
4, 4 AAVV. ANNALE NIVOMETEOROLOGICO DELLA

MONTAGNA VENETA-ANNI 1985-1986-1987


https://dandelion.eu/docs/api/datatxt/nex/v1/#parameters

Una volta terminata I'elaborazione otterremo una nuova colonna titolata “dataTXT”:

. rows records

¥ | Titolo

UL ALBO OPERATORI TURISTICI

ALIMENTAZIONE E SALUTE. GUIDA
METODOLOGICA PER L'EDUCAZIONE
ALIMENTARE

ANALIS| DENDROCRONOLOGICA DELLE
FORESTE DEL VENETO

ANNALE NIVOMETEOROLOGICO DELLA
MONTAGNA VENETA-ANNI 1985-1986-
1987

La cosa interessante € che:

Show: 5 10 25 50 rows

¥ dataTXT

Alimentazione
Choose new match

Salute

Choose new match
Educazione
Choose new match
Alimentazione
Choose new match
Dendrocronologia
Choose new match

Foresta

Choose new match
Veneto

Choose new match
Annali

Choose new match

¥ SottoTitolo

¥ | Anno

1991

1991

1990

¥ | Collana

¥ Materia

STORIA

SCIENZE
SOCIALI

SCIENZE
PURE

SCIENZE
PURE

s 1-50

¥ | SottoMateria

Geografia-
Turismo

Educazione-
Formazione-
Istruzione

Sc.naturali-
Geologia-
Sc.biologiche

Sc.naturali-
Geologia-
Sc.biologiche

e sono state aggiunte n righe per le n entita trovate all’interno del testo del titolo. A
esempio per “Alimentazione e salute. Guida metodologica per I'educazione alimentare”,

dataTXT ha estratto
o salute
o educazione

o alimentazione ( 2 volte, per alimentazione e alimentare )

e ogni entita & collegata alla relativa pagina di Wikipedia

Se confrontata con le colonne “Materia” e “Sottomateria” fa riflettere sulle potenzialita di un

tagging del genere automatizzato. Senza contare che ci sono i link a Wikipedia che possono

avere diversi potenziali utilizzi.

Tutorials ulteriori correlati su Open Refine
Dove si usa e si citano Zemanta, o OpenCalais, si pu0 usare dataTXT-NEX attraverso
I'estensione “Named Entity Extraction” appena citata.
Le tecnologie sottostanti utilizzate sono diverse, e producono quindi risultati diversi.

http://www.slideshare.net/brandwatchsocial/bdb-bethgranter

v C

http://schoolofdata.orq/2013/04/25/social-network-analysis-for-jour

nalists-using-the-twitter-api/ - pensiamo di analizzare il testo di

ogni singolo tweet, ad esempio, oltre che gli hashtag


http://www.slideshare.net/brandwatchsocial/bdb-bethgranter
http://schoolofdata.org/2013/04/25/social-network-analysis-for-journalists-using-the-twitter-api/
http://schoolofdata.org/2013/04/25/social-network-analysis-for-journalists-using-the-twitter-api/

m http://www.slideshare.net/lod2project/lod2-webinarzemanta201201
29-16603204



http://www.slideshare.net/lod2project/lod2-webinarzemanta20120129-16603204
http://www.slideshare.net/lod2project/lod2-webinarzemanta20120129-16603204
http://schoolofdata.org/handbook/recipes/cleaning-data-with-refine/
http://schoolofdata.org/handbook/recipes/cleaning-data-with-refine/
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